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Disclaimer 

The information contained in this RFE or any other information provided to Applicants, in writing, by 
or on behalf of the PFCCL and its employees or advisors is provided to Applicants on terms and 
conditions set out in this RFE and such other specific terms and conditions subject to which such 
information is provided. 
 

This RFE is not an agreement by itself and is neither an offer nor an invitation by PFCCL to Applicants 
or any other Person. The purpose of this RFE is to set the terms for the selection process and to 
provide Applicants with information that may be useful to them in preparation and submission of 
their Applications. 
 
This RFE includes statement which reflect various assumptions and assessments arrived at by the 
PFCCL and its employees or advisors. Such assumptions, assessments and statements do not 

purport to contain all information that Applicants may require. The information contained in this RFE 

may not be appropriate for all persons and it is not possible for the PFCCL and its employees or 
advisors to consider the data requirements, investment objectives, financial situation and particular 
needs of each Person who reads this RFE. The assumptions, assessments, statements and 
information contained in this RFE may not be complete, accurate, adequate or correct. Each 
Applicant should therefore conduct its own investigations and analysis and should check the 

accuracy, adequacy, correctness, reliability and completeness of the assumptions, assessments, 
statements and information contained in this RFE. 
 
The information provided in this RFE to Applicants is on a wide range of matters, some of which may 
depend upon interpretation of the law. The information given is not intended as a complete or 
authoritative statement under any law. PFCCL and its employees and advisors accept no 
responsibility or otherwise any obligation on any interpretation or opinion on laws expressed in this 

RFE. 
 
Except as specifically provided in this RFE, PFCCL and its employees and advisors make no 
representation or warranty, expressed or implied, and shall have no liability to any Person, including 
any Applicant, under any law, statute, rules or regulations or contract or tort or any principle of 

restitution or unjust enrichment or otherwise for any loss, damage, cost or expense which may arise 
from or that may be incurred or suffered on account of or in connection with anything contained in 

this RFE, including the accuracy, adequacy, correctness, completeness or reliability of this RFE and 
any assessment, assumption, statement or information contained in this RFE or deemed to form 
part of this RFE or otherwise supplied or arising in any way from the empanelment process of AMISP. 
It shall be deemed that by submitting the Application, an Applicant agrees and releases the PFCCL 
and its employees, agents and advisers, irrevocably, unconditionally, fully and finally from any and 
all liability for any claims, losses, damages, costs, expenses or liabilities in any way related to or 

arising from the exercise of any rights or performance of any obligations under this RFE or in 
connection with the Empanelment Process, to the fullest extent permitted by Applicable Law and 
waives any and all rights or claims it may have in this respect, whether actual or contingent, whether 
present or in the future. 
 
PFCCL and its employees and advisors also accept no liability of any nature, whether resulting from 
negligence or otherwise, arising from reliance of any Applicant upon the content of this RFE. PFCCL 

may, in its absolute discretion but without being under any obligation to do so, update, amend or 
supplement the information, assessment, statement or assumptions contained in this RFE. 

The issuance of this RFE does not imply that PFCCL is bound to qualify any Applicant or to select any 
Applicant for the stated purpose. PFCCL reserves the right to reject all or any of the Applications or 
cancel or withdraw the entire RFE process without assigning any reasons whatsoever and without 
any liability. 
 

This RFE, along with its Annexures, is not transferable. The RFE and the information contained 
therein is to be used only by the person to whom it is issued. It may not be copied or distributed by 
the recipient to third parties (other than in confidence to the recipient’s professional advisors). 
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1. Definitions and Interpretations 
 

1.1. Definitions 
 

1.1.1. The words and expressions beginning with capital letters and defined in this RFE shall, 
unless the context otherwise requires, have the meaning ascribed thereto herein. 

 
Addendum or 
Addenda 

shall mean an addendum or addenda to this RFE; 

Applicant shall mean any agency submitting its application for empanelment of 
Advanced Metering Infrastructure (AMI) Service Provider for 
implementation of Smart Prepaid Metering under RDSS Scheme as per 
the terms and conditions set out in this RFE; 

Application shall mean the response to this RFE submitted by an Applicant; 

Application Fee shall mean the fee mentioned in Clause 0; 

Empanelment Period shall mean the period provided in Clause 0; 

Empanelment 
Process 

Shall mean the process undertaken by PFCCL to select an Applicant for 
Empanelment of Advanced Metering Infrastructure (AMI) Service 
Provider for implementation of Smart Prepaid Metering under RDSS 
Scheme as per the terms and conditions set out in this RFE; 

Estimated Project 
Cost 

shall have the meaning as ascribed to in Clause 0; 

Financial Proposal shall have the meaning as ascribed to in Clause 2.2.6; 

Group shall have the meaning as ascribed to in Clause 0; 

PFCCL shall mean PFC Consulting Limited; 

RDSS shall mean the Revamped Distribution Sector Scheme Reforms-Based 
And Results-Linked of Govt. of India; 

RDSS Guidelines shall mean the latest version of the guidelines for RDSS including 
amendments thereof;  
Link: https://recindia.nic.in/rdss-guidelines-and-om  

RFE shall mean this Request for Empanelment document for empanelment 
of Advanced Metering Infrastructure (AMI) Service Provider for 
implementation of Smart Prepaid Metering under RDSS Scheme along 
with all schedules and annexures and shall include any modifications, 
amendments or alterations or clarifications thereto; 

RFP shall mean the Request for Proposal that would be issued by PFCCL 
after conclusion of the RFE stage as per Clause 0 of this document; 

Rupee or INR means Indian Rupee, the lawful currency of India;  

Technical Proposal shall have the meaning as ascribed to in Clause  0; 

SBD shall mean the latest version of the Standard Bidding Document for 
“Appointment of Advanced Metering Infrastructure (AMI) Service 
Provider for Smart Prepaid Metering in India on DBFOOT basis” 
including amendments thereof;  

Link: https://recindia.nic.in/SBD-AMISP 

 

1.2. Rules of Interpretation 

1.2.1. In this RFE 
(a) Table of Contents, headings and sub-headings are for convenience only and shall not 

affect construction and interpretation of this RFE; 
(b) the singular includes the plural and vice versa; 
(c) references to Articles, Sections, Clauses, Schedules, Appendix and Annexure are, 

unless the context otherwise requires, references to Articles, Sections, Clauses, 

Schedules, Appendix and Annexure of this RFE; 
(d) “includes” and “including” shall mean “including without limitation” or “but not 

limited to” whether or not they are followed by such phrases; 
(e) reference to any law or regulation having the force of law includes amendments, 

modifications, supplements, extensions or re-enactments thereof in future; 
(f) Any reference to time is a reference to the time in India; 
(g) Words and definitions not defined in this RFE but defined in the SBD shall have the 

meanings assigned to them in the SBD respectively. 

https://recindia.nic.in/rdss-guidelines-and-om
https://recindia.nic.in/SBD-AMISP
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2. Empanelment of AMISP 
 

2.1. Introduction 
 

2.1.1. Ministry of Power (MoP), Govt. of India has issued a Project Implementation Agency (PIA) 
Scheme under which PFCCL has been designated as one the PIAs for taking projects on 
implementation of Smart Metering for the States/Discoms under RDSS Scheme. As per the 
PIA Scheme, PFCCL has to provide an indicative quote to States/Discoms on per meter per 
month basis.  
 

2.1.2. Accordingly, PFCCL intends to empanel AMISPs in accordance with the terms and conditions 

provided in the SBD for implementation of Smart Prepaid Metering in India. 
 

2.2. Key features of empanelment 
 

2.2.1. The empanelled AMISP will undertake various activities as defined under the “Section 6: 

Project Requirements” in the SBD. 
 

2.2.2. Tenure of Empanelment: The tenure of empanelment of AMISPs shall be for a period of 
two (2) years which may be extended further on mutual consent.  
 

2.2.3. Appointment of AMISP by PFCCL: PFCCL will select AMISPs from amongst the 

empanelled AMISPs based on the RFP process carried out as per Clause 0 of this RFE from 
time to time for prospective projects to be taken up by PFCCL as PIA under each Group. 
 

2.2.4. Key changes compared to provision of SBD is provided in Chapter 2 of this RFE. In case of 
any conflict between the provisions of this RFE and SBD, the provisions of this RFE will 
prevail. 

 
2.2.5. Bidders will be empanelled in different groups as per the following:  
 

Group Region Project Size (by volume of Smart Meters) 

N1 
Norther Region (Chandigarh, Delhi, Haryana, 

Punjab, Rajasthan, Uttar Pradesh) 

0 to 5 Lakhs 

N2 5 to 10 Lakhs 

N3 > 10 Lakhs 

W1 Western Region (Chhattisgarh, Gujarat, 
Madhya Pradesh, Maharashtra, Dadra & Nagar 

Haveli and Daman & Diu, Goa) 

0 to 5 Lakhs 

W2 5 to 10 Lakhs 

W3 > 10 Lakhs 

S1 
Southern Region (Andhra Pradesh, Telangana, 

Karnataka, Kerala, Tamil Nadu, Puducherry) 

0 to 5 Lakhs 

S2 5 to 10 Lakhs 

S3 > 10 Lakhs 

E1 
Eastern Region (Bihar, DVC, Jharkhand, 

Odisha, West Bengal) 

0 to 5 Lakhs 

E2 5 to 10 Lakhs 

E3 > 10 Lakhs 

SPNER1 North-Eastern Region (Arunachal Pradesh, 

Assam, Manipur, Meghalaya, Mizoram, 

Nagaland, Tripura, Sikkim) 

0 to 2 Lakhs 

SPNER2 2 to 5 Lakhs 

SPNER3 > 5 Lakhs 

SPOTH1 Jammu & Kashmir, Ladakh, Himachal Pradesh, 

Uttarakhand, Andaman & Nicobar Islands and 

Lakshadweep 

0 to 2 Lakhs 

SPOTH2 2 to 5 Lakhs 

SPOTH3 > 5 Lakhs 

 
2.2.6. Accordingly, Applicants will be required to submit their Financial Proposal by quoting AMISP 

Service Charge on per meter per month basis as per Clause 3.5 of this RFE for the above 

groups. Such quote shall be valid for two (2) years from the date of empanelment of the 
AMISP. 
 

2.2.7. PFCCL shall open the Financial Proposal of each Applicant meeting the Eligibility and 
Qualification Requirements as per provisions of the SBD. PFCCL shall, for Applicants who 
have submitted a responsive Financial Proposal, tabulate the financial quotes from lowest 

to highest.  
 

2.2.8. A maximum of four (4) Applicants shall be empanelled for each Group.  
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2.2.9. First four (4) Applicants (in the order of lowest to highest financial quote) who agree 

unconditionally to match the lowest quote shall be empanelled for prospective projects to 
be taken up by PFCCL as PIA under each Group. In case the number of Applicants who 
agree to match the lowest quote is less than three (3), the next higher quoted Applicant(s) 

shall be asked to match the lowest quote for empanelment and so on, subject to maximum 
of four (4) empanelled Applicants under each Group. The meter type wise rate applicable 
for other Bidders who agree unconditionally to match the lowest quote shall be determined 
as per the following illustration:   

 

Meter Type 

Indicative Weightage 

of Quantity at RFE 

Stage 

Quote by L1 Quote by L2 
Revised Rate for L2 

to match L1 

Units->  INR/month/ meter INR/month/ meter INR/month/ meter 

Formula-> A B C 
D = C * 

102.30/115.10 

MT1 85.00% 100.00 120.00 106.66 

MT2 12.00% 110.00 80.00 71.10 

MT3 0.80% 120.00 125.00 111.10 

MT4 0.40% 130.00 85.00 75.55 

MT5 0.80% 140.00 70.00 62.22 

MT6 1.00% 150.00 160.00 142.21 

Weighted 
average 

Quote 

 
102.30 

(Sumproduct of A 

and B) 

115.10 
(Sumproduct of A 

and C) 

102.30 
(Sumproduct of A 

and D) 

 

2.2.10. PFCCL, reserves the right, at any time, to accept or reject any or all Applications, annul 
Empanelment Process and reject all Applications, at any time, without any liability or any 
obligation for such acceptance, rejection or annulment and without assigning any reasons 
whatsoever to any person, including the Applicants.  
 

2.3. Brief description of Empanelment Process 
 

2.3.1. PFCCL has adopted a single stage two-envelope process for empanelment of Applicants 
under various Groups. 
 

2.3.2. Each Applicant is required to submit a single Application as per format given in Clause 3.4 

of this RFE comprising of (a) the Technical Proposal and (b) the Financial Proposal as per 
the provisions of this RFE.  

 
2.3.3. Each Applicant shall submit only one (1) Technical Proposal mentioning the Group(s) that 

they are applying for, along with an Application Fee of INR One Lakh (INR 1,00,000) plus 
GST (as per applicable rate). An Application shall be summarily rejected if it is not 

accompanied with the Application Fee. The Technical Proposal shall demonstrate 
qualification for the Group having highest Estimated Project Cost amongst the Group(s) an 
Applicant is applying for. 
 

2.3.4. Technical Proposal shall be evaluated as per the provisions of the SBD. 
 

2.3.5. The estimated project cost for various Groups for the purpose of evaluation of Qualification 

Requirements and other provisions of the SBD shall be as follows: 
 

Group Estimated Project Cost (INR Cr) 

SPNER1, SPOTH1 200 (considering 2 lakh nodes) 

N1, W1, S1, E1, SPNER1, SPOTH1 450 (considering 5 lakh nodes) 

N2, W2, S2, E2, SPNER2, SPOTH2 875 (considering 10 lakh nodes) 

N3, W3, S3, E3, SPNER3, SPOTH3 1700 (considering 20 lakh nodes) 

 

2.3.6. The Financial Proposal of the Applicant shall be as per the project cost estimated by them 
for the entire contract duration as per SBD for undertaking various activities as defined in 
the SBD including site survey, planning, designing, financing, engineering, manufacturing, 
supply, transportation & insurance, delivery at site, unloading, handling, storage, 
installation, integration, testing, commissioning, demonstration for acceptance, training, 
maintenance, operation and documentation of various AMISP components etc.  
 

2.3.7. Gross Budgetary Support (GBS) under RDSS Guidelines needs to be factored in by the 
Applicant while submitting the Financial Proposal during the RFE stage as per the following: 
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Group GBS Category 

N1, W1, S1, E1, N2, N2, W2, S2, E2, N3, W3, S3, E3 Other than Special Category States 

SPNER1, SPNER2, SPNER3, SPOTH1, SPOTH2, SPOTH3 Special Category States 

 
2.3.8. The Applicant shall be required to provide Bid Security of INR One Crore (INR 1,00,00,000). 

An Application shall be summarily rejected if it is not accompanied by the Bid Security. The 
Applicant may be asked to submit additional Bid Security during the RFP process in line 
with the SBD. 
 

2.3.9. Any queries or requests for additional information relating to this RFE shall be submitted 
to PFCCL in accordance with the provisions of the SBD. 

 

2.4. Brief Description of RFP Process for any AMISP Project  
 

2.4.1. For each project during the Empanelment Period, PFCCL shall invite financial bids from the 

Applicants empanelled for the applicable Group. 
 

2.4.2. Empanelled Applicants (hereinafter referred as “Bidder”) under the applicable Group shall 
be required to submit their financial bids as and when invited by PFCCL along with any 

additional  Bid Security as per the terms of the SBD. Non submission of financial bids by 
empanelled Applicants shall lead to invocation of Bid Security by PFCCL. 
 

2.4.3. As part of its financial bid, the Bidder may also be required to quote prices for auxiliary LT 
Items and manpower cost with respect to new requirement for software component in line 
with the SBD for which the inputs shall be provided to the Bidders at the RFP stage. 
 

2.4.4. In addition to the GBS under RDSS, PFCCL may consider providing an additional payout to 
the AMISP on INR/ meter basis which will be declared to Bidders at the RFP stage. Such 
additional payout shall be released along with the GBS as per the provisions of the SBD.  

 
2.4.5. PFCCL shall recover a charge of INR [to be intimated at RFP stage]/ meter/ month from 

DISCOM against an additional payout of INR 1.00/ meter or multiple thereof. 
 

2.4.6. Accordingly, the AMISP Service Charge component of the financial bid submitted by a 
Bidder for the AMISP project shall be mandatorily lower than the following ceiling rate   

 

Ceiling Rate (INR/ 
meter/ month) 

= 
Empaneled Rate (INR/ 

meter/ month 
- 

INR X per meter per month * 
(Additional Payout by PFCCL in 

INR/ meter) 
 
2.4.7. While the RFP stage for a given project will be for the actual required quantity of meters of 

various types, the indicative weightage of quantity provided during RFE stage shall be 

considered for assessing conformance of the quoted rates to the ceiling rate requirement 
as per Clause 2.4.6. The same is explained in the following illustration:   

 

Meter Type 

RFE Stage RFP Stage 

Indicative 

Weightage 

of 

Quantity 

at RFE 

stage 

Quote by 

empaneled 
Bidder 1 

during RFE 

stage 

Quote by 

empaneled 
Bidder 2 

during RFE 

stage 

Weightage 

of 
Quantity 

at RFP 

stage 

Quote by 

empaneled 
Bidder 1 

during RFP 

stage 

Quote by 

empaneled 
Bidder 2 

during RFP 

stage 

Units-> % 
INR/month/ 

meter 

INR/month/ 

meter 
% 

INR/month/ 

meter 

INR/month/ 

meter 

Formula-> A B C D E F 

MT1 85.00% 100.00 106.66 90.00% 90.00          108.00  

MT2 12.00% 110.00 71.10 7.00% 110.00            80.00  

MT3 0.80% 120.00 111.10 0.80% 120.00            80.00  

MT4 0.40% 130.00 75.55 0.40% 130.00            80.00  

MT5 0.80% 140.00 62.22 0.80% 140.00            80.00  

MT6 1.00% 150.00 142.21 1.00% 150.00            80.00  

Weighted 

average Quote  
 

102.30 

(Sumproduct 

of A and B) 

102.30 

(Sumproduct 

of A and C) 

  

72.80 

(Sumproduct 

of D and E) 

85.20 

(Sumproduct 

of D and F) 

Charge to be 

recovered by 

PFCCL 

 20.00 20.00 

 

  

Ceiling rate  82.30 82.30    
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Meter Type 

RFE Stage RFP Stage 

Indicative 

Weightage 

of 

Quantity 

at RFE 

stage 

Quote by 

empaneled 
Bidder 1 

during RFE 

stage 

Quote by 

empaneled 
Bidder 2 

during RFE 

stage 

Weightage 

of 
Quantity 

at RFP 

stage 

Quote by 

empaneled 
Bidder 1 

during RFP 

stage 

Quote by 

empaneled 
Bidder 2 

during RFP 

stage 

Quote to be 
considered for 

ceiling rate 

conformance 

   

 73.80 

(Sumproduct 

of A and E) 
 

(Bid 

Accepted 

as 73.80 < 

82.30) 

83.80 

(Sumproduct 

of A and F) 
 

(Bid 

Rejected as 

83.80 > 

82.30) 

Quote to be 

considered for 

award of project 

   

 72.80 

(Sumproduct 

of D and E) 

85.20 

(Sumproduct 

of D and F) 

 
2.4.8. PFCCL may at its discretion also conduct an e-reverse auction. 

 
2.4.9. The financial bids of the Bidders would be evaluated as per the provisions of the SBD. 

 
2.4.10. Bidder submitting the lowest financial bid shall be selected for award of the project(s).  

 
2.4.11. PFCCL shall issue the Letter of Award (LoA) to the selected Bidder and proceed with the 

execution of the Contract. Bidder shall be required to submit Performance Security as per 
the provisions of the SBD. 
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3. Key Changes compared to the 
provision of SBD  
 

3.1. Qualification Requirements  
 

3.1.1. Clause 8.1 and 8.2 under “Section – 2: Eligibility and Qualification Requirements” of the 
SBD shall be revised as follows: 

 
“8.1 The technical and financial requirements of qualification are as follows: 
 

Sl. Requirements Supporting Documents 

Technical Requirements 

1. Sole/ Lead Applicant must have either: 

(a) paid for, or received payments for, 

construction of Eligible Project(s); 
Or 

(b) paid for development of Eligible project(s) 

in the Infrastructure sector in the last 
7 (seven) Financial Years with aggregate 
project value of not  less than 50% of the 
Estimated Project Cost 

 

a) References along with 

requisite contract/ 

Purchase Order (PO)/ 
Work Order (WO). The 
references should indicate 
client name, scope of 
work, Project start date 
(as per the format 

prescribed in Form 13 
given in Section 4); 
In case Non-Disclosure 
agreement (NDA) is signed 
with the client, Applicant 
shall provide an 

undertaking for the NDA 
and shall also provide a 
client certification as proof 
of experience along with 
Client Name/ Email 

Address/ Contact no./ 
designation etc. 

b) Documentary evidence of 
completion of the Project 
or completion of Go-live 
status (i.e., Go-live 
certificate, UAT testing 
certificate etc.) of the 
respective project as per 

the definition of Go-Live/ 
UAT specified therein or 
other documentary 
evidence indicating    
completion (e.g., proof   of   
payment   received/ proof 

of asset capitalized in 
books of accounts(as 

applicable) and client 
certificate for supply of 
material or similar proofs) 
along with contact details 
of the client; 

c) Any other documentation 
for implementation 
performance/ operation 

2. Sole/ Lead Applicant/ any other Consortium 
Member must have experience of 
integration of head-end system with MDM 
on standard interfaces and data exchange 

models for at least 50,000 consumers /end 
points (cumulatively) in an Indian/ Global 
Utility (power/ water/ natural gas/ telecom) 

in the last 7 (seven) years which are in 
operation for at least 1 (one) year. 

Or 
Sole/ Lead Applicant/ any other Consortium 

Member should have installed, integrated, 
tested, and commissioned control center 
hardware (or on cloud) and application 
software for at least 50,000 endpoints 
(cumulatively) in an Indian/ Global Utility 
(power/ water/ natural gas/ telecom) in last 
7 (seven) years which are in operation for 

at least 1(one) year 

3. The Sole/ Lead Applicant should have a 
valid pre-qualification and technical 
empanelment certificate for the required 

Valid Empanelment certificate 
of the sole/ lead applicant for 
the proposed solution, issued 
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Sl. Requirements Supporting Documents 

communication technology, issued by REC 

and approved by the committee constituted 
vide the letter issued by the Ministry of 
Power F.No.14/02/2021-UR&SI-II-Part(1)-
(E-258136) dt. 10th January 2022, at the 
time of bid submission. 

by REC / committee 

constituted thereby 

Financial Requirements  

4. The Applicant shall have positive net worth 
for each of the last three financial years. 
The Net worth of the Applicant should be at 
least 30% of the Estimated Project Cost in 
any of the last three Financial Years 

Or 
Applicant shall have a minimum ACI of 30% 
of the Estimated Project Cost at the close of 
the preceding financial year 
[Net Worth means sum total of the paid up 

capital and free reserves (excluding 

reserves created out of revaluation) reduced 
by aggregate value of accumulated losses 
(including debit balance in profit and loss 
account for current year) and intangible 
assets.]. 
[ACI means minimum investible funds (i.e., 
immediately available funds for investment 

and callable capital) subject to the limits of 
investment in a single investee entity (in the 
relevant jurisdiction for a Foreign 
Investment Fund, or the maximum 
permissible investment limit for an AIF) (as 
per the SEBI (AIF) Regulations, 2012, as 
may be amended from time to time), as 

applicable]. 
Please note: 

a. In case an Applicant and/(or) it’s 
Parent(s)/ Affiliate(s) has issued any 
fresh equity capital during the current 
financial year, the same shall be 

permitted to be added to the Applicant’s 
Net Worth subject to the statutory auditor 
of the Bidder certifying to this effect. 

b. In case an Applicant and/(or) it’s 
parent(s)/ Affiliate(s), being a SEBI 
registered AIF or Foreign Investment 
Fund, has received any fresh capital 

commitment available for the immediate 
deployment during the current financial 
year, the same shall be permitted to be 
added to the Applicant’s ACI subject to 
the statutory auditor of the Bidder 
certifying to this effect. 

Audited Annual financial 
statements, Balance Sheet 
and P&L Account for the 
respective Financial Years as 
per the format prescribed in 

Form 12 given in Section 4 

 

8.2.  The Sole/ Lead Applicant would have to clearly include and mention the details of all 
the solution / component providers given below. However, such solution / component 
providers may or may not necessarily be included as a part of the Consortium. For 
avoidance of doubt, it is clarified that the sole applicant/ any member of the consortium 
can also be a solution/ component provider, provided that they meet the relevant 

qualification requirements as mentioned below. The Sole / lead applicant has to 
mandatorily mention at least one vendor for each of the solution/ component providers 
given below in Form 1 of section 4: 

a) Smart Meter Manufacturer(s) 
b) Head End System (HES) solution provider 
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c) Meter Data Management System (MDMS) solution provider 

d) System Integrator 
e) RF Communication Provider (if applicable) 

 

The vendor details provided above shall not be changed during Empanelment Period. 
However, in exceptional circumstances, Applicant may replace their vendor(s) with prior 
approval of PFCCL, provided the new vendor meets all the Qualification Requirements 
mentioned in this RFE. 
 
Accordingly, in addition to the requirements above, the various solution / component 
providers should also separately meet the following requirements as on date of application 

submission or as on date of replacement of solution/ component provider post 
empanelment or award of contract, subject to necessary approval in writing from the 
PFCCL. Each of the solution / component providers shall sign an agreement with the sole/ 
lead applicant, provided the solution/ component provider is not the sole/ lead applicant, 
in the format as specified in Form 23 of section 4 of the SBD, clearly mentioning: 

a) their intent to comply with the terms and conditions of the AMISP Contract in the 

event the solution/ component provider is selected to undertake the Project 

b) their willingness to work with the said sole/ lead applicant; and 
c) their proposed roles and responsibilities.  

 

Sl. Requirements Supporting Documents 

A. Meter Manufacturer – Technical Requirements 

A1. Option 1: 
Should have manufactured and 
supplied minimum 1,00,000 nos. of 
Smart meters (cumulative) on 

proposed communication technology in 
Indian/Global Power Distribution Utility 
in the last 7 (seven) years. 
 
Option 2: 
Should have manufactured and 
supplied minimum 20,00,000 nos. of 

static electricity meters (cumulative) in 
Indian/Global Power Distribution Utility 

in the last 7 (seven) years. 
 
Option 3: 
Any meter manufacturer who doesn’t 
satisfy Option 1 & 2 but satisfies 

conditions (A2), (A3) & (A4) below, can 
also be eligible to participate in the 
empanelment process as a meter 
manufacturer. However, meters 
procured from          this particular meter 
manufacturer/ supplier, shall be 

limited to 25% of the total meters 
proposed to be implemented as part of 
AMISP project. 

a) References along with requisite 
contract/ Purchase Order (PO)/ 
Work Order (WO). The references 
should indicate client name, scope 

of work, Project start date (as per 
the format prescribed in Form 13); 
In case Non-Disclosure agreement 
(NDA) is signed with  the client, 
applicant shall provide an 
undertaking for the NDA and         shall 
also provide a client certification as 

proof of experience along with 
Client Name/ Email Address/ 

Contact no./ designation etc. 
 

b) Documentary evidence of 
completion of the Project or other 
documentary evidence indicating 
completion of supply (e.g. proof of 
payment received/ proof of asset 
capitalized in books of accounts (as 
applicable) and client certificate for 

supply of material or similar proofs) 
along with contact details of the 
client; 
 

c) Any other documentation for 
implementation performance/ 
operation 

A2. Smart meters shall have all the valid 
test certificate (issued within the last 5 

years) and BIS certificate, compliant to 

IS 16444 Part-1* 
Note: *At the time of supply of LT-CT 
operated Meters, the smart meters 
shall have all the valid test certificate 
and BIS Certificate, compliant to IS 
16444 Part-2. 

Valid BIS and type-test certificate to be 
submitted 

A3. Should have in-house NABL or ISO/ 
IEC - 17025 accredited Laboratory 

A valid registration certificate 
mentioning issue/renewal/expiry date 
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Sl. Requirements Supporting Documents 

A4. Should have a valid ISO 9001:2015 

certification 

Copy of valid certificate 

B. Head End System (HES) solution provider – Technical Requirements 

B1. The HES solution should have been 
successfully integrated with at least 2 

(two) different MDMS/ other utility IT 
Solution in Indian/ Global Utility(ies) 
(power/ water/ natural gas/ telecom) 
in last 7 (seven) years. 

Certificate / report issued by Client / 
MDMS OEM / solution provider. 

In case the HES solution provider, has 
integrated with their own MDMS, then a 
self-certification shall be provided. 

C. Meter Data Management System (MDMS) solution provider – Technical 
Requirements 

C1. The proposed MDM solution should 
have been successfully integrated with 
at least 2 (two) nos. of different HES 
solutions in Indian/ Global Utility(ies) 
(power/ water/ natural gas/ telecom) 

in last 7 (seven) years. 

a) References along with requisite 
contract/ Purchase Order (PO)/ 
Work Order (WO). The references 
should indicate client name, scope 
of work, Project start date (as per 

the format prescribed in Form 13 

given in Section 4); 
In case Non-Disclosure agreement 
(NDA) is signed with  the client, 
Applicant shall provide an 
undertaking for the NDA and    shall 
also provide a client certification as 

proof of experience along with 
Client Name/ Email Address/ 
Contact no./ designation etc. 

 

b) Documentary evidence of 
completion of the Project or 
completion of Go-live status (i.e., 
Go-live certificate, UAT testing 
certificate etc.) of the respective 
project as per the definition of Go-
Live/ UAT specified therein or other 

documentary evidence indicating 

completion (e.g., proof of payment 
received/ proof of asset capitalized 
in books of  accounts (as applicable) 
and client certificate for supply of 
material or similar proofs) along 

with contact details of the client 
 

c) Certificate / report issued by    Client 
/ HES OEM/ solution provider. In 
case the MDMS solution provider, 

has integrated with their own HES, 
then a self- certification shall be 
provided. 

 

d) Any other documentation for 
implementation performance/ 
operation. 

C2. The proposed MDM solution should 
have been successfully integrated with 
at least 2 (two) nos. of different Billing 
Systems in Indian/ Global Utility(ies) 
(power/ water/ natural gas/ telecom) 

or with Billing/ Other IT systems of 2 
(two) different Indian/ Global 
Utility(ies) in last 7 (seven) years. 

C3. Should have CMMi (Capability Maturity 

Model Integration) Level 3 or IEC/ISO 
27001 Certification (Software 
Development & Customization), as the 
requirement may be 

Copy of valid certificate 

D. System Integrator – Technical Requirements 

D1. Should have experience of integration 
of HES/MDMS etc. with at least 2 (two) 
billing / other utility IT systems in 
Indian/ Global Utility(ies) (power/ 
water/ natural gas/ telecom) in last 7 

Certificate / report issued by Client/ 
Billing system solution provider. 
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Sl. Requirements Supporting Documents 

(seven) years, in which the meters are 

in operation for at least 1(one) year. 

D2.  Should have valid ISO 
9001:2015 certification 

 Should have IEC/ ISO 27001 
certification or CMMi Level 3 (or 

above) certifications 

Copy of valid certificate 

E. RF Technology/ Solution Provider – Technical Requirements (If applicable) 

E1. The RF technology/ Solution provider 
should have implemented project/(s) 
with at least 50,000 (cumulatively) 

modules / endpoints involving Radio 
Frequency (RF) mesh in an Indian/ 
Global Utility (power/ water/ natural 
gas/ telecom) in the last 7 (seven) 
years. 

a) References along with requisite 
contract/ Purchase Order (PO)/ 
Work Order (WO). The references 

should indicate client name, scope 
of work, Project start date (as per 
the format prescribed in Form 13 
given in Section 4); 
In case Non-Disclosure agreement 
(NDA) is signed with the client, 

Applicant shall provide an 
undertaking for the NDA and shall 
also provide a client certification as 
proof of experience along with 
Client Name/ Email Address/ 
Contact no./ designation etc. 
 

b) Documentary evidence of 
completion of the Project or 
completion of Go-live status (i.e., 
Go-live certificate, UAT testing 

certificate etc.) of the respective 
project as per the definition of Go-
Live/ UAT specified therein or other 
documentary evidence indicating 
completion (e.g., proof of payment 
received/ proof of asset capitalized 
in books of accounts (as applicable) 

and client certificate for supply of 
material or similar proofs) along 
with contact details of the client; 
 

c) Any other documentation for 
implementation performance/ 
operation. 

E2. The RF Technology/ Solution provider 
should have been in the 
communications network installation / 

maintenance services business for the 
last 1 (one) year in India. 
OR 
The RF Technology/ Solution provider 
should have been in the 
communications network installation / 

maintenance services business for the 
last 3 (three) years outside of India. 

a) Certificate of Incorporation and 
Registration certificate along with 
Memorandum & Articles of 

Association. 
 

b) Copy of valid Licenses (In case of 
RF, Valid certificate issued by 

Wireless Planning & 
Coordination (WPC) Wing of the 
Ministry of Communications, GOI) 
as on date of bid submission. 

E3. The RF Technology/ Solution provider 
have successfully integrated their NIC/ 
Communication module with at least 3 
(three) different makes of smart meters 

in India or Outside of India. 

Signed agreements/ MoUs for 
integration of NIC module or Certificate 
of successful integration. 
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3.2. Important Dates, Amounts and Other Details  
 

3.2.1. Important Dates, Amounts and Other Details under “Section-1: Request for Proposal 
Notice” of the SBD shall be as follows: 
 
Dates 

   Date Time 

a) Commencement of downloading of this RFE   : 9.11.2023 10:00 hrs 

b) Pre-Empanelment meeting : 23.11.2023 11:00 hrs 

c) Last date for submitting the Application : 8.12.2023 15:00 hrs 

d) Date of Opening of Technical Proposal  : 8.12.2023 15:30 hrs 

e) Opening of Financial Proposal : To be intimated later 

 
Amounts for Bidding 

A. Application Fee to be submitted with 
the RFE (Non- Refundable) 

: INR 1,00,000 + GST (as per applicable 
rate) 

B. Bid Security (Refundable) : INR 1,00,00,000 

C. Transaction Fee for MSTC the E-

procurement portal (Non- 
Refundable) 

: INR 25,000 + GST (as per applicable rate) 

C. Other Payments or Bank Guarantees for the AMISP shall be as per the terms and 
conditions  defined in the SBD 

 
Other Details 

A. Address for Communication including Contact details: 
Name Sh. Anupam Kashyap 
Designation Chief Manager 

Address 9th Floor, A-Wing, Statesman House, Connaught Place, New 
Delhi – 110 001 

Tel 011-23443999 
Email anupam_kashyap@pfcindia.com 

 

B. Payment of Application Fee (non-refundable): 

1. Application Fee shall be made in the form of A/C payee demand draft in favour 
of PFC Consulting Ltd. or RTGS   payable at New Delhi drawn on any Scheduled 
Commercial Bank. 

2. Application Fee (or its receipt in case of RTGS payment) and Bid Security must 
be submitted in physical form in a sealed envelope at address given above, 
before the Application Submission Deadline. The sealed envelope shall be 
clearly marked on the top as “Application Fee for Empanelment of Advanced 

Metering Infrastructure (AMI) Service Provider for Implementation of Smart 
Prepaid Metering under RDSS Scheme” The sealed envelope shall also clearly 
mention the name of the Lead Consortium Member/ Sole Applicant submitting 
the Application, as further detailed in Section 3. 

3. Any Application not accompanied by Application Fee and Bid Security as above 
shall be rejected by PFCCL as non- responsive. 

4. Application Fee and Bid Security are non-refundable 

 

3.3. Bid Data Sheet  
 

3.3.1. Bid Data Sheet under “Section-3: Instructions to Bidders and Bid Data Sheet” of the SBD 
shall be as follows (the clauses which are not mentioned here shall be as per the SBD): 

 
ITB 
Reference 

A. General Provisions 

1 (oo) PFCCL has issued this Empanelment of Advanced Metering Infrastructure 
(AMI) Service Provider for implementation of Smart Prepaid Metering 
under RDSS Scheme. 

2.2 The RFE process shall be conducted through/ with Electronic – 
Procurement (e- Procurement/ e- Tendering) System. 
 

PFCCL shall use the E-procurement portal of M/s MSTC Ltd to manage this 

mailto:anupam_kashyap@pfcindia.com
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ITB 

Reference 

A. General Provisions 

RFE process at https://www.mstcecommerce.com/eproc/. 
 

The Instructions to Bidder for using for MSTC’s E-Procurement Portal can 
be referred at Annexure A. 
 

This RFE can be downloaded from www.pfcclindia.com and 
https://www.mstcecommerce.com/eproc/ from 9.11.2023 at 10:00 hrs 
onwards  

2.2.2 Name Sh. Anupam Kashyap 

Designation  Chief Manager 

Address 9th Floor, A-Wing, Statesman House, Connaught 
Place, New Delhi – 110001 

Tel 011-23443999 

Email anupam_kashyap@pfcindia.com 
 

2.3 Empanelment of Advanced Metering Infrastructure (AMI) Service Provider 
for implementation of Smart Prepaid Metering under RDSS Scheme. 

2.4 To be provided at the RFP stage  

2.6 A Pre-Empanelment Meeting will be held through Video Conferencing (VC) 
on MS Teams on 23.11.2023 at 11:00 hours (IST). The link for the Pre-

Empanelment Meeting is as follows: 
https://teams.microsoft.com/l/meetup-
join/19:41da425e42574e50a283be66b0d6053f@thread.tacv2/16994170
24996?context=%7B%22Tid%22:%2251f27efd-60ca-4b0e-ac0f-
3742ab80f269%22,%22Oid%22:%22fa4353fe-71b2-4305-a61f-
7473834bf04b%22%7D 

2.8 Format for Sending Query to PFCCL 
 

[Query may be sent in hard copy to the Nodal Officer of PFCCL, at the 
below-mentioned address AND/ OR via email to E-mail ID] 
 

[Reference No.] 
 

From: 
[Address of the Bidder] 
[Telephone No., Fax No., Email] 

[Date] 
 

To: 

Sh. Anupam Kashyap 
Chief Manager 
PFC Consulting Limited 
9th Floor, A-Wing, Statesman House 
Connaught Place, New Delhi – 110 001 
 

Sub: Query. 
Ref: RFE No. PFCCL/RFE/Smart_Metering/2023/1 for “Empanelment of 
Advanced Metering Infrastructure (AMI) Service Provider for 
implementation of Smart Prepaid Metering under RDSS Scheme” 
 

Dear Sir/ Madam, 
 

Please find below our query with respect to the RFE subject to the terms 
and conditions therein: 

Sr
. 

Reference Clause No. Page No. Query 

1.    

2.    

3.    

 

Thanking you, 
Yours Sincerely, 

[Insert Signature here] 
[Insert Name here]  
[Insert Designation here] 

 

https://www.mstcecommerce.com/eproc/
http://www.pfcclindia.com/
https://www.mstcecommerce.com/eproc/
mailto:anupam_kashyap@pfcindia.com
https://teams.microsoft.com/l/meetup-join/19:41da425e42574e50a283be66b0d6053f@thread.tacv2/1699417024996?context=%7B%22Tid%22:%2251f27efd-60ca-4b0e-ac0f-3742ab80f269%22,%22Oid%22:%22fa4353fe-71b2-4305-a61f-7473834bf04b%22%7D
https://teams.microsoft.com/l/meetup-join/19:41da425e42574e50a283be66b0d6053f@thread.tacv2/1699417024996?context=%7B%22Tid%22:%2251f27efd-60ca-4b0e-ac0f-3742ab80f269%22,%22Oid%22:%22fa4353fe-71b2-4305-a61f-7473834bf04b%22%7D
https://teams.microsoft.com/l/meetup-join/19:41da425e42574e50a283be66b0d6053f@thread.tacv2/1699417024996?context=%7B%22Tid%22:%2251f27efd-60ca-4b0e-ac0f-3742ab80f269%22,%22Oid%22:%22fa4353fe-71b2-4305-a61f-7473834bf04b%22%7D
https://teams.microsoft.com/l/meetup-join/19:41da425e42574e50a283be66b0d6053f@thread.tacv2/1699417024996?context=%7B%22Tid%22:%2251f27efd-60ca-4b0e-ac0f-3742ab80f269%22,%22Oid%22:%22fa4353fe-71b2-4305-a61f-7473834bf04b%22%7D
https://teams.microsoft.com/l/meetup-join/19:41da425e42574e50a283be66b0d6053f@thread.tacv2/1699417024996?context=%7B%22Tid%22:%2251f27efd-60ca-4b0e-ac0f-3742ab80f269%22,%22Oid%22:%22fa4353fe-71b2-4305-a61f-7473834bf04b%22%7D
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ITB 

Reference 

B. Preparation of Proposals 

12.1 The Application submitted by the Applicant shall remain valid until i.e. up 
to and including 180 days reckoned from the Application Submission 
Deadline specified in this RFE, as may be extended by PFCCL. 

12.2 Currency and the amount of Bid Security to be furnished by the Bidder is: 
Currency: INR 

Amount: 1,00,00,000 

12.3(a) Banks by whom Bank Guarantee is required to be issued: Any 
Commercial Bank 

12.3(a) Not Applicable 

13.1 Clarifications may be requested no later than 15 days prior to the 
Application Submission Deadline. 
Request to be sent at: 
 

Sh. Anupam Kashyap 
Chief Manager 
PFC Consulting Limited 
9th Floor, Statesman House 

Barakhamba Road 
Connaught Place, New Delhi – 110001 

Telephone: 011-23443999 
Email: anupam_kashyap@pfcindia.com 
Website: www.pfcclindia.com 

15.13 Number of years: 10 years 

16.4 As per Clause 0 of this RFE 

 

ITB 
Reference 

C. Submission, Opening and Evaluation 

17.6 Details to be marked on the sealed envelope: 
 

RFE No. PFCCL/RFE/Smart_Metering/2023/1 for “Empanelment of Advanced 
Metering Infrastructure (AMI) Service Provider for implementation of Smart 

Prepaid Metering under RDSS Scheme” 
Application Submission Deadline: [.] 
Time and Date of Technical Proposal Opening: [.] 

Name of the Lead Consortium Member/ Sole Applicant submitting the 
Application: [.] 
 

Sealed Envelope(s) to be addressed to:  
 

Sh. Anupam Kashyap 

Chief Manager 
PFC Consulting Limited 
9th Floor, Statesman House 
Barakhamba Road 
Connaught Place, New Delhi – 110001 
Telephone: 011-23443999 
Email: anupam_kashyap@pfcindia.com 

17.10 The Application Submission Deadline is:  
Date: 8.12.2023 
Time: 15:00 hrs 

19.1 The Technical Proposals shall be opened as indicated below: 
 

The opening shall take place through the Technical Proposal opening 

meeting to be held over a Video Conferencing on: 
 

Date & Time: 8.12.2023 at 15:30 hrs 
Link for the bid opening meeting will be made available at least 1 day prior 
to the Technical Proposal opening event, at PFCCL’s website 
www.pfcclindia.com   

 

 

http://www.pfcclindia.com/
mailto:anupam_kashyap@pfcindia.com
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3.4. Format of Covering Letter of the Application  

[Covering Letter shall be on the official letterhead of the So le  App l i cant /  Lead Consortium 

Member of the Consortium] 

[Reference No.] 
From: 
[Address of the Lead Consortium Member/ Sole Applicant] 
[Telephone No., Fax No., Email] 
[Date] 

To: 

Sh. Anupam Kashyap 
Chief Manager 
PFC Consulting Limited 
9th Floor, A-Wing, Statesman House 
Connaught Place, New Delhi – 110 001 

Sub: Application for Empanelment of Advanced Metering Infrastructure (AMI) Service 

Provider for Implementation of Smart Prepaid Metering under RDSS Scheme 

Ref: RFE No. ______ 

Dear Sir/ Madam, 

We, the undersigned ……………. [Insert name of the Lead Consortium Member/ Sole Applicant] having 
read, examined and understood in detail the RFE for Empanelment of Advanced Metering 
Infrastructure (AMI) Service Provider for Implementation of Smart Prepaid Metering under RDSS 
Scheme submit our Application comprising of Technical and Financial Proposals. 

1. We give our unconditional acceptance to the RFE including but not limited to all its instructions, 
terms and conditions, and formats attached thereto, issued by PFCCL, as amended. In token of 
our acceptance to the RFE, the same have been initialed by us and enclosed to the Application. 
We shall ensure that our Consortium shall execute such requirements as per the provisions 
of the RFE and provisions of such RFE shall be binding on us. 

2. Fulfilment of Eligibility 

We undertake that we fulfil the Eligibility Criteria stipulated in the SBD and fulfil all the eligibility 

requirements as the Lead Consortium Member/ Sole Applicant as outlined in the SBD. 

We hereby confirm that in accordance with Clause 7 of Section 2 of the SBD, we are herewith 
submitting legally binding undertaking supported by a board resolution from the 
……………………....[insert name of Technically Evaluated Entity and/or Financially Evaluated Entity 
or its Ultimate Parent Company, as the case may be] that all the equity investment obligations 
of …………………. [insert name of the Sole Applicant/ Lead Consortium Member] shall be deemed 

to be equity investment obligations of the …………………… [insert name of Technically Evaluated 
Entity and/or Financially Evaluated Entity or its Ultimate Parent Company, as the ease may be] 
and in the event of any default by……………….….... [insert name of the Sole Applicant/ / Lead 
Consortium Member], the same shall be met by …………………………. [insert name of Technically 
Evaluated Entity and/or Financially Evaluated Entity or its Ultimate Parent Company, as the case 
may be].  

[To be inserted only in ease the Applicant has sought qualification on the basis of technical and 

financial capability of its Affiliate(s) and/or its Parent] 
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3. Bid Security 

We have enclosed a Bid Security of [Amount] in the form of a Bank Guarantee No. ……………. 
[Insert Bank Guarantee Number] (OR Demand Draft) dated …………….[Insert date of the Bank 
Guarantee] as per Form 6 given in Section 4 from …………….[Insert name of Bank providing Bid 

Bond] and valid up to [Date]. 

4. No Deviation 

We have submitted our Financial Proposal strictly as per terms and formats of the RFE, without 
any deviations, conditions and without mentioning any assumptions or notes for the Financial 
Proposal in the said format. 

5. Acceptance 

We hereby unconditionally and irrevocably agree and accept that the decision made by PFCCL 

in respect of any matter regarding or arising out of the RFE shall be binding on us. We hereby 
expressly waive any and all claims in respect of Bid process. 

We confirm that there are no litigations or disputes against us, which materially affect our ability 
to fulfil our obligations with regard to fulfilling our obligations as per the RFE. 

6. Familiarity with Relevant Indian Laws and Regulations 

We confirm that we have studied the provisions of the relevant Indian laws and regulations as 

required to enable us to submit this RFE and execute the RFP Documents, in the event of our 
selection as Selected Bidder. We further undertake and agree that all such factors as mentioned 
in the AMISP Contract have been fully examined and considered while submitting the Application. 

7. Compliance with applicable laws/ guidelines for public procurement in India 

We confirm that we shall adhere to applicable laws for public procurement in India including the 
guidelines issued in Order No. F/No.6/18/2019-PPD by Ministry of Finance, Department of 
Expenditure, Public Procurement Division dated 23 July 2020, Order No No.9/16/2016-Trans-

Part (2) dated 18 November 2020, latest Government of India Guidelines for Make in India, 

Domestically manufactured products, Atmanirbhar Bharat and circulars DIPP Office 
Memorandum No. P-45021/2/2017-PP (BE-II) date:16th Sept. 2020, MeitY Circular 
No.1(10)/2017-CLES dated 06.12.2019 and Order No. 11/05/2018-Coord. by the Ministry of 
Power dated 17 September 2020 including any amendments or modifications to the same from 
time to time. 

8. Contact Person 

Details of the contact person representing our Consortium/ Sole Applicant (registered Company) 
supported by the Power of Attorney prescribed in Form 10 given in Section 4 of the SBD are 
furnished as under: 

Name: …………………………………………………. 
Designation: …………………………………………………. 
Company: …………………………………………………. 

Address: …………………………………………………. 
Mobile: …………………………………………………. 

Phone: …………………………………………………. 
Fax: …………………………………………………. 
Email: …………………………………………………. 

a. We are submitting herewith the Technical Proposal containing duly signed formats, both in 
electronic and physical forms, (duly attested) as desired by you in the RFP for your 

consideration. 

b. We are also submitting herewith the Financial Proposal in electronic form only, as per the 
terms and conditions in the RFE. 
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9. It is confirmed that our Application is consistent with all the requirements of submission as stated 

in the RFE and subsequent communications from PFCCL. 

10. The information submitted in our Application is complete, strictly as per the requirements 
stipulated in the RFE and is correct to the best of our knowledge and understanding. We would 

be solely responsible for any errors or omissions in our Application. 

11. We confirm that all the terms and conditions of our Application are valid for acceptance for a 
period of 180 days from the Application Submission Deadline. 

12. We confirm that we have not taken any material deviation so as to be deemed non-responsive 
with respect to the provisions stipulated in the RFE. 

13. We confirm that we are participating for following Groups and are submitting our Financial 
Proposal separately for each Group: 

Group Yes/No 

N1  

N2  

N3  

W1  

W2  

W3  

S1  

S2  

S3  

E1  

E2  

E3  

SPNER1  

SPNER2  

SPNER3  

SPOTH1  

SPOTH2  

SPOTH3  

14. We confirm that we have submitted Financial Proposal(s) as per the format provided in the RFE.  

15. We confirm that no order/ ruling has been passed by any Competent Court or Appropriate 
Commission against us or any of our Consortium Members or in the preceding one (1) year from 
the Application Submission Deadline for breach of any contract and that the Bid Security 

submitted by the us or any of our Consortium Members has not been forfeited, either partly or 
wholly, in any bid process in the preceding one (1) year from the Application Submission 
Deadline. 

16. We confirm that we are not currently blacklisted by any Govt. Organization or Regulatory 
Agencies or Govt. undertaking. 

17. We confirm that we are not currently banned/ debarred by PFCCL/ Utility or any of their 
subsidiaries/ holding company 

18. We are registered/ exempt from registering in accordance with applicable laws [Evidence of valid 
registration by the Competent Authority shall be attached if applicable] 

Dated the ……………. [Insert date of the month] day of ……………. [Insert month, year] at ……………. 

[Insert place]. 

Thanking you, 

Yours Sincerely, 

[Insert Signature here] 
[Insert Name here] 
[Insert Designation here] 
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3.5. Financial Proposal  

3.5.1. “Annexure: Quoted prices for the Financial Bid” under “Form 1: Format of Submission of Financial Bid (For Reference Only)” under “Section 5. 

Financial Proposal - Forms” of the SBD shall be as follows: 

Section A: Bill of Materials and Services for Smart Meters. (To be provided for each Group separately)  

S. 
No. 

Item Description  
(A) 

Indicative 
Weightage 
of Quantity 
in % (B)* 

Rate per Unit including all 
taxes and duties other than 

GST (in INR/  meter/ 
month) (C) 

GST 
applicable in 

% (D) 

AMISP Service Charge 
(in INR/ meter/ 
month) (E = C x 

(1+D%) 

1 
Single Phase Whole current Smart Meter 5-30A, 240V P-N (with Net 
Metering) – Consumer Meters with Meter Box, Back-end IT Infra with 
associated works and requisite no. of polycarbonate seal 

85%    

2 
Three Phase Whole current Smart Meter 10-60A,3x240V P-N (with 
Net Metering) - Consumer Meter with Meter Box and Back-end IT 
Infra with associated works and requisite no. of polycarbonate seal 

12%    

3 

HT Meters 3-phase (63.5V Ph-N, +/-5 A) (with Net Metering) – 
Consumer Meters with control cables, with DI provisions Meter Box 
and Back-end IT Infra with associated works and requisite no. of 

polycarbonate seal 

0.8%    

4 

HT Meters 3-phase (63.5V Ph-N, +/-5 A) (with Net Metering) – Feeder 
Meters with control cables, with DI provisions Meter Box and Back-
end IT Infra with associated works and requisite no. of polycarbonate 
seal 

0.4%    

5 

LT-CT Meters (3-phase 240V Ph-N, +/-5 A (with Net Metering) – 
Consumer Meters with control cables, without DI provisions Meter Box 
and Back-end IT Infra with associated works and requisite no. of 
polycarbonate seal 

0.8%    

6 

LT-CT Meters (3-phase 240V Ph-N, +/-5 A) (with Net Metering) – DT 
Meters with CTs, control cables, with DI provisions Meter Box and Back-
end IT Infra with associated works and requisite no. of polycarbonate 
seal 

1%    

Weightage Average AMISP Service Charge (i.e. Sum of Product of (B) and (E) ÷ Sum of (B))  

* This is an indicative figure only and may vary during RFP stage on case-to-case basis for different project(s).  
 

Note: 

The cost under the above table are inclusive of supply, erection/ installation, setting up of the complete communication network & integration of items 

with existing system along with related hardware, software & equipment after successful completion of Field Installation and Integration Test (FIIT) as 

well as carrying out FMS activities as per the SBD and any other activity for successful completion of the contract.  
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Annexure A 

Instructions to Bidder for using for MSTC’s E-Procurement Portal 

Bidders are requested to read the terms & conditions of this tender before 

submitting their bid online. 

1. Process of E-tender: 

A) Registration: The process involves vendor registration with the MSTC e-

procurement portal which is free of cost. Only after registration, the vendor(s) 
can submit his/their bids electronically. This submission of bids shall be done over 

the Internet. The Vendor should possess a valid Class III signing and encryption-
type digital signature certificate. Vendors are to make their own arrangements 
for bidding from a computer connected to the Internet. MSTC is not responsible 

for making such arrangements. (Bids will not be recorded without a Digital 
Signature). 

SPECIAL NOTE: THE PRICE BID HAVE TO BE SUBMITTED ON-LINE AT 
www.mstcecommerce.com/eproc 

i. Vendors are required to register themselves online with 

https://www.mstcecommerce.com/eproc → Register (Fill up details 

and create your own user id and password) → Submit. Please follow the 
‘Registration Guide’ available in the Registration link before proceeding. 

ii. Vendors will receive a system-generated mail confirming the registration 

in their email which has been provided while filling out the registration 
form. 

iii. The Vendors shall have to subscribe to the buyers and categories in order 

to receive system-generated mail. In order to subscribe, a vendor has to 

log in and click on ‘My Subscription’ followed by ‘Add Subscription’. On 
successful subscription, a system-generated mail shall be forwarded to the 
vendor. Please follow the guide for ‘Subscription’ of ‘Download Guides’ 

available in the Dashboard before proceeding. 

2. For specific queries/ clarifications, please contact MSTC: 

Contact person (MSTC Ltd Delhi): 

Ms. Archana, Deputy Manager, Email id-archana@mstcindia.co.in 

Phone number-9990673698 

 

For Technical Help: HO Central Help Desk 

1. Phone Number 

07969066600 

http://www.mstcecommerce.com/eprochome/mstc
http://www.mstcecommerce.com/eproc
mailto:id-archana@mstcindia.co.in
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2. Email 

helpdeskho@mstcindia.in 

Please mention "HO Helpdesk" as subject while sending emails 

3. Availability 

9:30 AM to 5:00 PM on all working days for all Technical issues relating to e-
auction, e-Tenders, System settings, etc. 

NRO Help Desk: 

4. Phone Number 

01123212357, 01123215163, 01123217850 

B. System Requirement: 

a) Operating System –Windows 7 and above  

b) Web Browser- Preferred ‘IE 8’ and above.  

c) Security Settings:   

i) Tools=>Internet Options=>Security=>Disable Protected Mode If enabled-i.e., 

Remove the tick from the box mentioning “Enable Protected Mode”.  

ii) Tools => Internet Options => Security =>Custom Level=>  

 Active X control & plug-ins: Enable all Active-X Controls   

 Scripting: Enable “Allow Status Bar Update Via Script” 

 Disable “Use Pop-up Blocker”  

d) Java: JRE 8 Latest update  

e) Other Settings:  

i) View => Toolbars=> “Tick” Status Bar.  

ii) Tools=>Internet Options=> General=> Click on Settings under “Browsing 
history/Delete Browsing History”=> Temporary Internet Files=>Activate “Every 

time I Visit the Webpage”.  

f) For new Version of IE or other “Active –X Filtering” under Tools should not be 

ticked.  

g) Tools =>Internet Options=> Security=> Selected Trusted Sites=> Add 
Website http://www.mstcecommerce.com.  

2. The tender will be opened electronically on a specified date and time as 
given in the NIT. 

mailto:helpdeskho@mstcindia.in
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3. All entries in the tender should be entered in online Price Bid Formats 
without any ambiguity. 

4. All notices and correspondence to the bidder(s) shall be sent by email only 
during the process, up to the finalization of the tender by MSTC. Hence the 

bidders are required to ensure that their official email ID provided is valid 
and updated at the stage of registration of vendor with MSTC (i.e. Service 
Provider). Bidders are also requested to ensure the validity of their DSCs 

(Digital Signature Certificates). 

5. E-tenders cannot be accessed after the due date and time. 

6. Bidding in e-tender: 

a. The process involves Electronic Bidding for submission of Bid. 

b. The bidder(s) can submit their Bid through the internet on the MSTC Website 
www.mstcecommerce.com/eproc 

c. The NIT/ Documents shall be available for download in the event catalog 
available under ‘Event Details’ of the Event. 

d. Please follow the guides for ‘Uploading encryption public key’ and ‘Bidding’ 
under ‘Download Guides’ available in the Dashboard before proceeding to 

submit a bid. 

e. The bidders may upload the bidding-related documents in the link ‘My 

Documents’. The documents uploaded here shall be available for attaching 
with this event on the Bid Floor. 

f. In order to submit a bid, a vendor has to go to ‘Events’ from the menu and 
select ‘Bid Floor’. The vendor has to select the buyer ‘PFC Consulting 

Limited” from the buyer list in order to view the live events list.  The correct 
event has to be selected from the event list for participation. A vendor has to 
submit ‘Event wise bid details’ that may consist of ‘Common Terms’ and/ or 

‘Document Attach’. A vendor has to save the Common Terms and/ or attach 
documents by clicking the respective buttons. Once the event-specific bids 

are saved, the status is updated in ‘Event specific bid status’ and the ‘Item 
specific bid’ button appears on the bid floor. Thereafter vendor has to click 
the button under ‘Technical Cover’ in order to save the technical bid for 

specific lots. Once the technical bid is saved, the ‘Price Cover’ button appears 
on the screen for respective lots. Once the price bid is saved, the vendor has 

to click on ‘Final Submit’. On final submission of the bid, the status of the bid 
submission shall display ‘Bid submitted’ under ‘Item specific bid status’. A 
vendor shall receive system-generated mail.  

NOTE: - The bid cannot be revised once the Final Submit button has been clicked 
by the bidder. However, if the bidder wishes to change his bids then he may delete 

the bid and re-submit the same. 

g. In all cases, the bidder should use their own ID and Password along with a 

Digital Signature at the time of submission of their bid. 

http://www.mstcindia.com/
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h. During the entire e-tender process, the bidders will remain completely 

anonymous to one another and also to everybody else. 

i. The e-tender floor shall remain open from the pre-announced date & time 

and for the duration mentioned above. 

j. All electronic bids submitted during the e-tender process shall be legally 

binding on the bidder. Any bid will be considered as the valid bid offered by 
that bidder and acceptance of the same by Buyer will form a binding contract 
between Buyer and the Bidder. 

k.  It is mandatory that all the bids are submitted with digital signature 
certificate otherwise the same will not be accepted by the system. 

l. Buyer reserves the right to cancel or reject or accept or withdraw or extend 
the tender in full or part as the case may be without assigning any reason 

thereof. 

m.  No deviation of the terms and conditions of the tender document is 

acceptable. Submission of bid in the e-tender floor by any bidder confirms his 
acceptance of terms & conditions for the tender. 

n. Unit of Measure (UOM)is indicated in the e-tender Floor. Rate to be quoted 
should be in Indian Rupee as per UOM indicated in the e-tender floor/tender 

document. 

7. Any order resulting from this e-tender shall be governed by the terms and 

conditions mentioned therein. 

8. No deviation to the terms & conditions are allowed. 

9. Buyer has the right to cancel this e-tender or extend the due date of receipt 

of bid(s) without assigning any reason thereof. 

10.The online tender should be submitted strictly as per the terms and 

conditions and procedures laid down in the website 
www.mstcecommerce.com/eproc of MSTC Ltd. 

11.The bidders should upload all the documents required (if any) as per terms 

of NIT. Any other document uploaded which is not required as per the terms 
of the NIT shall not be considered. 

12.The bid will be evaluated based on the filled-in Price bid formats. 

13.Canvassing in any form in connection with the Tender is strictly prohibited 
and the bids submitted by the bidders who resort to canvassing are liable 

to be rejected. 

 

 

http://www.mstcecommerce.com/eproc

